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Finding your way around
FINDING YOUR WAY AROUND

This guide describes how to configure SurfControl Mobile Filter once you have installed Service Pack 2.
Service Pack 2 enhances SurfControl Mobile Filter to give you:

• Secure LDAP communication between Mobile Filter and the domain controller.

• The ability to configure the port between the client and Mobile Filter server.

• Network installation of clients via group policy.

• The ability to make the client invisible to the user.

• Secure communication between the client and the server.

• Increased client deployment security.

For setting up rules that apply to Mobile Filter clients see Chapter 8 - Rules Administrator of the Web Filter
Administrators Guide. Mobile Filter users and hosts can be selected from the Who objects tab.

THE MOBILE FILTER ADMINISTRATOR
The Mobile Administrator (see Figure 1) is where you manage your SurfControl Mobile Filter clients. It
contains a configurable description of each remote device with it’s settings. 

Figure 1 The Mobile Filter Administrator

Once you can see your clients within the Mobile Administrator you can edit their filter settings. When you
select an individual client in the top pane of the Administrator, it’s details will appear in the bottom pane. 

Note: if you select multiple clients the only details that will appear in the bottom pane are those that 
are common to each client.
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Finding your way around
To see the Mobile Filter Administrator Select Start > Programs > SurfControl Web Filter > Mobile
Administrator.

Selecting Clients to view and/or configure
To view and configure the filtering of client devices, you need to select the client that you want to configure.
Select clients individually or in multiples, using the SHIFT or CTRL key.

• Click the Find First button to find one client of a particular type. 

• Click the Find All button to find a group of clients of a particular type.
Procedure 1 Changing client properties

Step Action

1 Select the clients that need changing.

2 Change the properties in the Properties panel and click the Commit Changes button.
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Administrator Menus
ADMINISTRATOR MENUS

The following menu options are available in the Mobile Filter Administrator:

FILE 
The File menu enables you to open databases and close the Administrator. 

Open... 
The Open... menu enables you to open a database of Mobile Filter clients to be administered by the Mobile
Administrator. Only Mobile Filter compatible databases can be opened in the Administrator.

Exit
Enables you to close the Mobile Administrator.

EDIT 
The Edit menu enables you search, select and delete clients. 

Find
Find enables you to use a keyword search to locate particular clients. If you have a lot of clients and only want
to configure those of a certain type, you can use Find to select only those clients that contain the criteria that
you are looking for.
Procedure 2 Searching for clients

Step Action

1 Choose Find... from the Edit menu or click  on the toolbar.

2 The Find dialog box will appear.

Figure 2 The Find dialog

• Find what:- enter the text you want to 
find.

• Search Columns - select the check-
boxes that correspond to the columns 
that you want to search.

3 Enter the text or characters that you want to be included in the search into the ‘Find what:’ text box.

4 Indicate which column you want to search by selecting the relevant ‘Search Columns’ check boxes.

5 Click Find First to have the first client that fulfills this criteria highlighted or Find All to have every 
client highlighted.
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Administrator Menus
Find Next 
The Find Next menu item enables you to find the next Mobile Filter client that matches the search criteria. 

Select All 
Choosing Select All selects all of the clients in the Administrator.

Invert Selection
This reverses the selection status of the clients in the Administrator. For example if clients 2, 4 and 6 are
selected and 1, 3 and 5 are not, selecting Invert Selection will deselect clients 2, 4 and 6 and select clients 1, 3
and 5.

Delete Client
Delete Client removes the client from the Mobile Administrator. If you have not selected ‘Reject new client
installs’ in the Server Settings dialog, the client will reappear the next time the Mobile Administrator opens.

VIEW
The View menu enables you to specify how you want the Mobile Administrator to look by adding or hiding
toolbar buttons and the status bar. You can also use the View menu to change the columns within the
Administrator: 

Toolbar
Select Toolbar to show the Shortcut buttons or deselect it to hide them.

Status Bar
Select Status Bar to show the status values at the bottom of the Administrator or deselect it to hide them.

Columns
To sort client data click the Heading at the top of the column. The data will be sorted into alphabetical order.
Clicking the column again will reverse the order of the sort. This menu contains two sub-menus:

• Reset Positions - If you have moved columns to different places in the table select this to restore all
columns to their original positions. To move a column to a different position, select the column heading
then drag and drop it into its new position. You can return it to its original position at any time by
choosing Columns > Reset Positions.

• Reset Widths - Selecting Reset Widths restores the column widths to their default setting

Refresh 
Selecting Refresh updates the information in the Mobile Administrator by refreshing the details.
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Administrator Menus
CONFIGURE
The Configure menu enables you to specify global attributes for clients as well as the location and scope of
your corporate Web Filter installations.

Server Settings 
Server Settings enables you to specify whether the Mobile Filter server is accepting new clients, and what the
global default user name and host name are. You can also set the number of concurrent client sessions
available for uploading of log files. See “Offline action issues” on page 14, for more details.

Most of the settings available within the Administrator are specific to the clients that are installed to the server.
However, there are some settings that are global to the server which can be configured in the Administrator.
These include the default User name and Host name. The User name is a ‘catch-all’ name given to a client in
the event that a client name is not specified. It enables SurfControl Mobile Filter to apply settings to the client
even without a specified name. One reason you might want to change this is if you already have a user account
set up that is used by a low privileged user in the absence of their own account. Setting the User name to this
account name will make sure that anyone using this account will be filtered automatically.
Procedure 3 Configuring Server settings

Step Action

1 Select Server Settings from the Configure menu to see the Server Settings dialog. 

2 Enter the following information:

• User Name - Enter or edit a system value which can be used for the ‘Server default’ user name.

• Host Name - Enter or edit a system value which can be used for the ‘Server default’ host name.

• Offline Log Synchronization - If the server goes offline, the clients will not be able to connect to 
verify whether a Web page should be allowed or not. If you have set your clients to ‘Log & Allow’ 
then all Web pages will be allowed but a log will be kept as to what pages are being visited. Once 
the server is back on-line these logs will be uploaded onto the server. However, if too many clients 
attempt to do this at one time it can result in the server becoming less responsive to client filter 
requests. Select ‘Maximum concurrent client sessions’ to limit the number of clients that can 
connect at one time.

• Server Lockdown - Select the ‘Reject new client installs’ check-box called to specify whether new 
clients can or cannot be installed to the Mobile Filter server. 

Figure 3 The Server Settings dialog

• User Name - The ‘Server default’ user name.

• Host Name - The ‘Server default’ host name.

• Offline Synchronization - Deals with how many client log 
files can be uploaded onto the server at any one time 
(see Step 2 for more details).

• Server Lockdown - Rejects new client installs if selected.

3 Click OK.
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Administrator Menus
New Client Defaults 
When a client is installed to the Mobile Filter server certain default settings are used. You can change these
default values by setting up the New Clients Defaults dialog box. Any clients that are installed after this point
will contain these settings.
Procedure 4 Configuring New Client Defaults.

Client Upgrade Details
Client Upgrade Details specify whether there is an upgrade available for Mobile Filter clients. See ‘The Mobile
Filter client - Upgrading your Mobile Filter clients’ in the Installation Guide for more details.

Step Action

1 Select New Client Defaults from the Configure menu.

2 In the the New Client Defaults dialog box, enter the following information:

• Offline Action: - set how the client will behave if the Mobile Filter server becomes unavailable. See 
“Client Details section” on page 12 for more details. The default is Allow All.

• Unfiltered Ports: - set how the client should behave towards ports that are not included for 
filtering. See “Dealing with unfiltered ports” on page 14. The default is Allow All.

• Filter Sensitivity: - set how much filtering is carried out. See “Setting filtering sensitivity” on 
page 15 for more details. The default is High.

• Visibility Level - set how much of Mobile Filter the user sees. The default is Medium:

- Full - all features and pop-ups will be visible to the user.

- Medium  - the Client UI will be available but pop-ups will be disabled. 

- Stealth - no features will be available to the user. Only pop-ups containing a critical message 
will be shown.

• Preferred Host Name: - set the name for the device that is being filtered. See “Host name” on 
page 18 for more details. The default is client specified.

• Preferred User Name: - set the name for the user of the device that is being filtered. See “Visibility 
Level” on page 16 for more details. The default is client specified.

Figure 4 New Client Defaults

• Offline Action: - How clients will behave if 
the server goes offline.

• Unfiltered Ports: - How Mobile Filter treats 
ports that are not included for filtering.

• Filter Sensitivity: - The strength of filtering.

• Visibility Level: - How much of the client 
interface the user sees. The default is 
medium.

• Preferred Host Name: - The name of the 
device being filtered.

• Preferred User Name: - The name of the user 
of the device being filtered.

3 Click OK.
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Administrator Menus
Adding Corporate Web Filters 
Mobile Filter has the ability to recognize when it is in the vicinity of an installation of the corporate Web Filter
product, which will then take over filtering of the client.
Procedure 5 Adding a corporate Web Filter server 

Step Action

1 Select Corporate Web Filters from the Configure menu. You will see the Corporate Web Filters dialog.

2 Click Add>> to expand the dialog box and enter the IP address of the Web Filter server along with a 
subnet mask to show the range of IP addresses that Mobile Filter has to look for.

Figure 5 Corporate Web Filters dialog

• Add>> - Add a new IP address.

• Edit>> - Edit an existing IP address.

• Remove>> - Remove an existing IP 
address.

• IP Address - The IP address of the Web Filter 
server.

• Mask - The subnet mask for this network.

• Corporate Network Detection Service is 
installed - indicate whether CNDS is 
installed. See your Mobile Filter Installation 
Guide for more details.

• Port Number - The port number that the 
connection to CNDS will use.

• Default Port - Sets the port number to the 
default.

3 Once you have added all of the details that you need, click Accept to add the new IP address and 
Mask to the list. You will see the new server appear in the list pane which will now be enabled.

4 Click OK. 
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Administrator Menus
Editing Corporate Web Filter servers
You can edit any of the corporate Web Filter servers that you have added to the Mobile Filter Administrator
using the Corporate Web Filters dialog.
Procedure 6 Editing an existing corporate Web Filter server

Step Action

1 Select Corporate Web Filters from the Configure menu.

2 In the Corporate Web Filters dialog, select the Web Filter server from the list.

Figure 6 Selecting the Web Filter 
server

• Add>> - Add a new IP address.

• Edit>> - Edit an existing IP address.

• Remove>> - Remove an existing IP 
address.

3 Click Edit to expand the dialog.

Figure 7 Editing the Web Filter server 
details

See Step 2 Figure 5, for an explanation of 
fields in this dialog.

4 Make the required changes to the server settings and click Accept..

5 Click OK to apply the changes.
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Administrator Menus
CNDS
If your organization consists of more than one site, and you have a corporate Web Filter server in each one,
then you can add each of these to the Mobile Administrator as a list. When a Mobile Filter client logs into the
Mobile server, it informs the server of its IP address. This IP address is then tested against each Corporate
Web Filter entry in the Corporate Web Filters dialog box to see if the Client’s IP address exists within the range
specified by each IP address and subnet mask.

The first entry found that matches the Client is then reported back for any additional checking against the
CNDS, if installed. If it does not make a match with the first server it will try the next one in the list until it has
tried them all. If no match is found, the client continues to filter, assuming it is not within its own corporate
network.

TOOLS
The Tools menu enables you to set passwords and override them in the event of problems.

Password Bypass Generator
To uninstall a client you need to supply the password that you entered during the client installation. If you
forget this password you will have to use Password Bypass to override the original password and uninstall the
client without it.
Procedure 7 Using Password Bypass Generator

Step Action

1 If you find, when you are asked for your password that you cannot remember it, click the Password 
Bypass button in the Uninstall Password dialog on the client.

Figure 8 Uninstall Password

• Password -  Enter the Client password.

• Password Bypass... - Start to generate a bypass for this 
password if you can’t remember it.

2 You will see a Password Bypass dialog which carries a code in the Challenge Code edit field. 

3 Go to the Mobile Filter Administrator select Tools > Bypass Generator.

4 Copy the Challenge Code from the client into the ‘Challenge Code:’ edit field of this dialog.

Figure 9 Password Bypass Generator

• Challenge Code: - The code that you copy from the 
Client Password Bypass dialog.

• Response Code: - The code that appears when you click 
Generate.

• Generate - Generates the Response Code.

5 Click Generate.
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Administrator Menus
Set Server Pass-phrase
During the installation of the Mobile Filter client on to a user’s device, it registers with the Mobile Filter server
and it’s details are written to the Mobile Filter database. During this registration process the server passes a
pass-phrase (created during the installation of Service Pack 2) to the client. The following illustrates how this
pass-phrase can be used:

PROBLEM

• The Mobile Filter database has been deleted/corrupted and cannot be restored. The server administrator
creates a new database.

• The client attempts to log onto the server to ask for a categorization. The logon fails because the new
database contains no details of this client (the client did not register with THIS database during
installation).

• The client attempts to re-register. Re-registration requires that the client’s details already exist in the
database. As this is not the case, the client is not allowed to log on to the Mobile Filter server.

SOLUTION

The Set Server Pass-phrase deals with a situation like this in the following way:

• After the administrator has created the new Mobile Filter database, he assigns the same pass-phrase to this
database as the one used for the old database that no longer exists (using the Set Server Pass-phrase
dialog).

• The client tries to log on to the server for a categorization which fails (because there are no client details in
the database). The client obtained the pass-phrase during the client upgrade process. It now passes this
pass-phrase to the server. 

• The server checks that the password matches the one assigned to the new database (which it does because
the administrator has assigned the old pass-phrase to the new database), then writes the client’s details to
the new database. It then allows the client to log on.

6 A code will appear in the ‘Response Code:’ text box.

7 Go back to the client and copy this Response Code from the server into the ‘Response Code:’ text box 
of the Client Password Bypass dialog.

8 Click OK to proceed with uninstalling the client.

Note: Once you have configured the server to use a new database, you MUST restart IIS. This is to ensure 
that the scnmISAPIExt.dll picks up the new settings.

Step Action
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Administrator Menus
Setting a new Pass-phrase. If you have created a new database using the Database Creation Tool the new
database will not have a pass-phrase assigned to it.
Procedure 8 Setting a new Pass-phrase

Changing a Pass-phrase. If you need to change your pass-phrase you can use the Set Server Pass-phrase to
do this.
Procedure 9 Changing a Pass-phrase

HELP

About SurfControl Mobile Administrator
The About box contains information such as the version number of the Mobile Filter installation, the name of
the category database and how many days are left on your subscription.

Step Action

1 Opening the Mobile Administrator, will show a message telling you that no Server Pass-phrase has 
been set. Click OK.

2 In the dialog that follows, enter a pass-phrase for the new database. The ‘Enter existing pass-phrase:’ 
is grayed out because a pass-phrase has not yet been assigned to this new database.

3 Enter a new pass-phrase and confirm it: The new password must be between 8 - 16 characters long.

Figure 10 Set Server Pass-Phrase

• Enter existing pass-phrase - This will be grayed out if no 
pass-phrase has been set.

• Enter new pass-phrase - The new pass-phrase that you 
want to add.

• Confirm new pass-phrase - The same pass-phrase 
entered again for confirmation.

4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon. 
The pass-phrase will then be passed to it.

Step Action

1 Select Set Server Pass-phrase from the Tools menu.

2 Enter the old password into the ‘Enter existing pass-phrase:’ text box.

3 Enter the new pass-phrase and confirm it: The new password must be between 8 - 16 characters long

4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon. 
The new pass-phrase will then be passed to it.
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Client Details section
CLIENT DETAILS SECTION

CLIENT DESCRIPTION
This reflects the description added during the client’s installation. You can edit the initial description in the
Description field in the bottom pane. Details relating to the client are shown in Table 1. These are specified by
the client and cannot be edited in the Mobile Administrator.
Table 1 Client Details

Field Description

Client ID Unique ID that helps locate a specific client installation. This ID is also visible in the 
client. See “Client properties” on page 22 for more details.

Platform Type The client operating system. It is useful when locating and/or grouping installations.

Client Type Identifies the Processor, Operating System Description and Language variant of a 
Mobile Filter client.

Client Version Identifies the version number of the Mobile Filter client and indicates whether an 
upgrade is available.

Install Date Date on which the Mobile Filter client software was installed on the selected device.

Last Logon Date Date the client last made an Internet request that was logged by the Mobile 
Administrator.

Tamper Count Tamper count - Should the client detect an unauthorized change to any of the offline 
log files or the gateway URL in the registry, it will notify the server that a tamper has 
occurred. Once the server has been notified that the client has been tampered with, it 
will increase the tamper count for that client.

Password Password that was supplied during the client’s installation process and is required if 
you uninstall the client.
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Client Details section
OFFLINE ACTION
There may be times when the Mobile Filter server is not available to the client, perhaps because of connection
difficulties or maintenance. When this happens the client will try to contact the server on a regular basis (every
five minutes) while connected to the Internet, until it can re-connect to the server. If the server is busy this can
take between ten to sixty minutes. While the server is unavailable the client will be unable to send Web requests
to the server for categorization so must deal with these requests itself. The client can be set to perform any of
the following: Allow All, Block All and Log & Allow. 
Procedure 10 Setting Offline Action

Step Action

1 Select the client/s that you want to set the offline action for.

2 Click the arrow on the Offline Action: list to expand it:

Figure 11 Offline Action List

• Allow All - every Web request will be allowed 
(the default).

• Block All - every Web request will be blocked.

• Log & Allow - every Web request will be 
allowed but each request will be written to a 
log file. The Mobile Filter client will indicate 
to the end user their filtering status so the 
user of the filtered device could be aware 
when their activity is being logged but not 
filtered. However, any attempt by the user to 
delete any of these log files will be detected. 
See the next section, ‘Offline Action Issues’ 
for more information.

3 Choose the type of Offline Action that you require, from the list. 

4 Click Commit Changes to add the new Offline Action setting to the client in the Mobile Filter client 
Administrator.
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Client Details section
OFFLINE ACTION ISSUES
When a server is offline the client repeatedly polls the server until it can re-connect to it. As soon as the client
establishes a successful connection, any offline logs are sent to the Mobile Filter server. 

This is a good way to keep a record of users' activities while the server is unavailable but it can cause problems
if too many clients attempt to upload their log files at one time. To stop this from happening the Server
Settings dialog box can be edited. ‘Maximum concurrent client sessions’ enables you limit the number of
clients that can upload their log files at any one time. See “Server Settings” on page 5 for more information.

DEALING WITH UNFILTERED PORTS
Filtering of ports depends on what rules you have created and what ports are available to be monitored. There
are three ways in which these unknown ports can be dealt with:Allow All, Block All and Filter. 
Procedure 11 Setting Unfiltered Ports

Step Action

1 Select the client/s that you want to set the unfiltered ports behavior for.

2 Click the arrow on the Unfiltered ports: list to expand it:

Figure 12 Unfiltered ports list

Unfiltered ports actions:

• Allow All - allow access to all 
unfiltered ports without 
contacting the Mobile Filter server 
to see if there is a rule set up for 
the port (this is the default).

• Block All - block access to any 
unfiltered ports without 
contacting the Mobile Filter server 
to see if there is a rule set up for 
the port.

• Filter - contact the Mobile Filter 
Server to see if any rules are set to 
apply to all ports. 

3 Choose the type of action that you require for unfiltered ports, from the list.

4 Click Commit Changes to save the new Unfiltered Ports: setting. 
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Client Details section
SETTING FILTERING SENSITIVITY
Filtering sensitivity enables you to set how much filtering is carried out by Mobile Filter clients. Reducing the
level of filtering can speed up performance on slow connections, but of course at the same time less traffic is
filtered. Priority can be assigned on four levels High, Medium, Low and Automatic. 
Procedure 12 Setting up Filter Sensitivity

Step Action

1 Select the client/s that you want to set the filtering sensitivity for.

2 Click the arrow on the Filter Sensitivity: list to expand it:

Figure 13 Filter sensitivity list

Filter Sensitivity strengths:

• High - all non-HTTP ports and all HTTP 
requests are categorized. There may be a 
performance impact if the client is making 
a lot of requests on a slow internet 
connection.

• Medium - all non-HTTP ports are 
categorized but only HTTP page requests 
are categorized while Images/sounds/style 
sheets, and XML requests are not 
categorized.

• Low - all non-HTTP ports are categorized. 
For HTTP requests, the URL will be 
categorized and, if allowed the domain 
level part of the URL is cached for 3 
minutes.

• Automatic - the client chooses High, 
Medium or Low based on the average 
Mobile Filter server response times and 
pre-configured thresholds.

3 Choose the level of filtering from the list.

4 Click Commit Changes to save the new Filter Sensitivity setting.
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Client Details section
VISIBILITY LEVEL
You can set up Mobile Filter to hide some or all of its features from the user. There are three levels of visibility:
Full, Medium and Stealth.

Procedure 13 Setting up Visibility Level

Note: If the client tries to access a port that is blocked, they will see a warning pop-up, regardless of the 
visibility setting.

Step Action

1 Select the client/s that you want to set the visibility level for.

2 Click the arrow on the Visibility Level: list to expand it:

Figure 14 Visibility Level list

Visibility levels:

• Full - Full visibility. All features and pop-ups 
will be visible.

• Medium - The user interface will be visible to 
the user but pop-ups will be disabled though 
critical messages will be shown. This is the 
default setting for a new client.

• Stealth - No features will be visible to the 
user. Only pop-ups containing critical 
messages will be shown.

Note: The client interface will be displayed 
when an upgrade is available, even if the 
client is set to Stealth mode.

3 Choose the level of visibility from the list.

4 Click Commit Changes to save the new Visibility setting.
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Client Details section
USER NAME
The User Name specifies the name used by the Mobile Filter server for all categorizations for the client device.
This name will then be checked against the rules in the Rules Administrator to see if it appears in a rule. This
name can be either be the system user name or a name you have created for this user. There are three types of
User Name that can be used: Client specified, Server override and Server default.
Procedure 14 Setting Client User names

Step Action

1 Select the client(s) that you want to set the user name for.

2 Click the arrow on the User Name: list to expand it:

Figure 15 Client User Name list

Client user name list:

• Client specified - when the user logs 
into their remote device, for example a 
laptop computer, they will have to log 
into the operating system using a user 
name and password. ‘Client specified’ 
sends this user name to the server and 
this is used in subsequent filtering.

• Server override - this is a user name that 
you specify to identify this user as a 
member of the organization without 
specifically defining them as an 
individual. It is particularly useful for 
devices that cannot supply a user name. 
A cell phone would be such a device, 
although Mobile Filter does not support 
the use of cell phones as yet. You could 
enter a user name such as 
‘remote_user’ for each cell phone that 
you are going to use. This would enable 
any user of this cell phone to be filtered 
regardless of who they are.

• Server default - this is a user name that 
will be used in the absence of a ‘Client 
specified’ or ‘Server override’ user 
name, thus enabling the device to still 
be filtered.

3 Choose the type of User Name that you require from the list.

4 Click Commit Changes to save the new User name specification setting.
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Client Details section
HOST NAME
The Host name specifies the actual device itself rather than the person who is using the device. It means that
devices or groups of devices can be recognized and filtered regardless of who is actually using them. This is
divided into three types of host name:

• Client specified - when the user logs into their remote device, for example a laptop computer, the
network name of the device is sent to the Mobile Filter server and is used in subsequent filtering. When
this device is added to a rule as a Who object, the rule can be applied to the device as if it were a user
irrespective of the user using it.

• Server override - this is a host name that you specify to identify this device as a member of a particular
group. It is particularly useful for devices that cannot supply a host name. You could enter a host name
such as ‘remote_device’ for each device that you are going to use. This would enable any device thus
named to be filtered.

• Server default - this is a host name that will be used in the absence of a ‘Client specified’ or ‘Server
override’ hostname, thus enabling the device to still be filtered.

PASSWORD
This is the password that is needed to uninstall the Mobile Filter Client.
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Other Configuration
OTHER CONFIGURATION

Once you can see your clients within the Mobile Administrator you can select any of these and use the bottom
half of the Administrator interface to change their filter settings. These clients can then be added to
SurfControl Web Filter rules so that you can apply your company filtering policy to them.

PORTS THAT CAN BE FILTERED
To reduce the amount of communication between Mobile Filter clients and servers, the clients only
communicate activity on those TCP ports of interest. To perform filtering on a specific port, an appropriate
protocol/port ‘Where’ object must be applied to rules. Those rules that do not contain a protocol/port
‘Where’ object are assumed to apply to HTTP ports only. The SurfControl Mobile client only filters ports that
appear in active rules.

PORTS THAT CAN BE MONITORED
You can set the protocols to be monitored or unmonitored (see “Monitoring Specific Protocols” in Chapter  6
of the Web Filter Administrator’s Guide for more information). The SurfControl Mobile client both filters and
intercepts activity on those ports chosen to be monitored within the SurfControl Monitor, and informs the
Mobile Filter server.

Monitoring issues with Mobile Filter
You should be aware of the following when using the Monitor with Mobile Filter:

• In the Site Details and User Details panes, the ‘Bytes Sent’, ‘Bytes Received’ and ‘Duration’ fields will not
display data because of the way in which the Mobile Filter client and server communicate.

• The ‘Allowed/Blocked’ status of off-line traffic will display as ‘Allowed’ in the Monitor. This is because at
the time the Mobile Filter server was off-line and the client device was not being filtered by Mobile Filter.
This is only applicable when the status of off-line traffic is set to ‘Log and Allow.’
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Other Configuration
SECURITY AND MOBILE FILTER
SurfControl Mobile Filter now offers support for secure connection:

• Between the Mobile Filter server and your LDAP server

• Between the Mobile Filter server and client.

Mobile Filter server and LDAP server
A secure connection can now be made between the Mobile Filter server and your LDAP server. During
installation you were asked to specify whether you required a secure or non-secure connection. You can change
this setting by editing the SecureConnection registry setting. 
Procedure 15 Changing the registry setting

Step Action

1 Open the registry using regedit and navigate to:

HKEY_LOCAL_MACHINE\SOFTWARE\JSB\SurfControl Scout

2 Set the SecureConnection DWORD value:

• 1 - gives a secure connection though there will be an impact on connection speed.

• 0 - connection is faster but unsecure.
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The Mobile Filter Client
THE MOBILE FILTER CLIENT

If a client is not set to Stealth it will inform any user of any change in the way it is filtering. If a request is
denied the user will see an appropriate Deny page corresponding to the rule that has been triggered. Non-
HTTP requests (including HTTPS) will show a pop-up window containing a message if the visibility level on
the client is set to 'Full'. These will also be recorded in a Message history window with the most recent
messages at the top, as in Figure 16. These messages are not permanently stored.

CLIENT STATUS ICONS
Once the Mobile Filter client is installed on the mobile device your users will see an icon in the status area, as
long as the client visibility is not set to Stealth. The available icons are described in Table 1:

CLIENT PROPERTIES
Mobile Filter client properties can be seen by double-clicking the Mobile Filter system tray icon (see Figure 17).
You can also right-click the icon and select Open from the pop-up menu. This will launch the Mobile Filter
dialog box which contains the following tabs:

• General

• Messages

• About

Note: No client properties can be seen if the client visibility is set to Stealth. 

Table 2 Client Icons

Icon Description

The Mobile Filter Server is offline, and offline action is set to Allow All.

Server is offline, and offline action is set to Block All.

Server is offline, and offline action is set to Log & Allow.

The client has switched off as a local Web Filter is already filtering the device.

The product Icon. This is used while the client is using the Mobile Filter Server for filtering.

The client is waiting for the user to access the Internet before trying to log on to the Mobile Filter 
server.
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The Mobile Filter Client
General
The General tab contains three sections:

Figure 16 Mobile Filter General tab

• Details - this shows a summary of the Mobile Filter client settings, showing how filtering is set up, the
client ID (this can be given by the user to an administrator or Technical Support so that they can identify
the device within the Mobile Administrator) and the level of filtering sensitivity. See “Setting filtering
sensitivity” on page 15 for more information on this setting.

• Categorization Statistics - every time an Internet request is made the Mobile Filter client contacts the
Mobile Filter server to have the request categorized and have any appropriate rules applied. ‘Server
Response (Last):’ shows how quickly the server responded to the client’s last request while ‘Server
Response (Average):’ gives an average of the speed of communication based on the response times it has
collected. If the last categorization failed the last response time will be preceded by the word ‘Failed’. 

For example 

– If the last categorization took 10 ms: Server Response (Last) 10ms.

– If the last categorization failed: Server Response (Last) Failed 65000ms.

• Actions - clicking Synchronize with Server immediately updates the client with any client side changes
made on the Mobile Filter server.

Note: Clicking Synchronize with Server will not update the last response time. 
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The Mobile Filter Client
Messages
Every time there is a change in the way the Mobile Filter client is filtering it will display a message relating to
what has occurred (see Figure 18). These messages are stored in the Messages pane with the most recent at the
top:

Figure 17 Mobile Filter Messages tab

About
The About tab (see Figure 19) tells you the version number of the product and can be used as a reference for
upgrading etc:

Figure 18 Mobile Filter About tab

Note: If the client visibility is set to Medium, only messages concerned with blocked ports, tampers and 
upgrades will be displayed.
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The Mobile Filter Client
CLIENT SECURITY
During installation, the Mobile Filter server’s contact information is stored in the registry of the client machine
as the Gateway URL. Some users may try to change this URL to avoid being filtered. The client can detect
unauthorised changes and automatically repair invalid entries. It does this in the following way:

• If the gateway URL in the registry is not formed correctly, it will instantly be replaced with the last gateway
URL that was used  by the client to successfully contact the server. A tamper will be logged.

• If the gateway URL contained in the registry is valid but cannot be contacted, the client will enter it's
default offline action state. It will then check the gateway URL periodically for a specified period of time
(24hrs by default). 

• If the server cannot be contacted after the specified time period, the gateway URL in the registry, and the
last successfully connected gateway URL will be compared. 

– If the two are different, the gateway URL in the registry will be changed to match the last successful
gateway URL. A tamper will be raised and the client will attempt to connect to the server using the
updated gateway URL in the registry.  

– If the two gateway URL's are the same, the client remains in it's offline state and will periodically poll
the server.
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The Mobile Filter Client
GROUP POLICY AND CLIENT CONFIGURATION
It is now possible to use Group Policy to configure the Mobile Filter server (and port) to be used by clients.
Procedure 16 details the steps that must be followed in order to add the new SurfControl template to the
Administrative Templates within a Group Policy Object, as well as how to configure the new server
information.

The following instructions assume that you are familiar with Active Directory and using the Microsoft Group
Policy Manager to apply policies to machines or groups of machines. 
Procedure 16 Applying Group Policy to the Gateway URL

Step Action

1 Open Group Policy Manager on the Mobile Filter server.

2 Right-click the Default Domain Policy object and select Edit.

3 In the Group Policy Object Editor select Computer Configuration > Administrative Templates.

4 Right-click and select Add/Remove Templates..

5 In the Add/Remove Template dialog that follows click Add.

6 Navigate to the Scmfcli.adm file. By default this will be stored in:

C:\Program Files\SurfControl\Web Filter\Tools

7 Select the file Scmfcli.adm and click Open.

8 Click Close in the Add/Remove Templates dialog.

9 Expand the Administrative Templates folder in the Group Policy Manager and you will now see a list 
of directories beneath it.

10 Select SurfControl Mobile Filter Client then select Server URL in the right-hand pane.

11 Click the Properties hyper-link.

12 In the dialog that follows select the Enabled option. This will enable the URL text box underneath.

13 Enter the following URL:

<protocol>://<server.domain:port>/scnmgw/scnmisapiext.dll

where <protocol> is either http or https and <server.domain:port> is the name of your server 
and domain. The optional port specification, :port, enables you to use a different port to the 
defaults of 80 for http and 443 for https.

Note: Do not alter the name, or the path to, the dll.
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The Mobile Filter Client
CONNECTIONS BETWEEN CLIENT AND SERVER USING SP2
If you are using IIS v5.0, once a connection to an ISP is established it is maintained and remains open
indefinitely until the client logs off. This may be a problem if you have to pay for your network use on a ‘pay
for time used’ basis. This is not an issue with IIS v6.0 so upgrading to this IIS version should fix the problem.

Figure 19 The Server URL Properties dialog

• Not Configured - no Group Policy URL has been added.

• Enabled - the Group Policy URL will override the default 
Gateway URL setting in the registry.

• Disabled - the Group Policy URL has been added  but it 
has been disabled.  The default Gateway URL will be 
used.

• URL: - the URL to the Mobile Filter server.

14 Click OK.

Step Action
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Troubleshooting
TROUBLESHOOTING

If you are encountering difficulties with a client, we recommend that you perform the following procedures in
the order listed. It is advisable to retest the client between each step:

• Try closing and restarting the problematic application.

• Open the Mobile Filter client UI, and click the Synchronize with Server button.

• Restart the computer.

• Check the Mobile Filter Web site for an up to date list of known problems.

• Re-run the Mobile Filter client setup and try the Repair option.

• Uninstall the Mobile Filter client software, reboot and then re-install the software.

CLIENT NOT FILTERING
Mobile Filter has the intelligence to know when it is in the company environment so that it will switch off and
leave the filtering to the company web filter. It does this by recognizing the range of IP addresses that it is
exposed to and recognizing that it is within it’s own network. However, companies can use ranges of IP
addresses which can be duplicated across different companies. If the Mobile Filter client should go into an
environment that consists of IP addresses within the same range of those of the company from which it
originates then it will think that it is now within its own company and will switch off.

CLIENT NOT PICKING UP CHANGE TO OFFLINE ACTION
When a Mobile Filter client cannot communicate with the Mobile Filter Server, perhaps because the server is
offline, the Mobile Filter client applies filtering to the device depending on the Offline Action that was present
within the Mobile Administrator at the last successful connection to the Mobile Filter Server. This means that,
although you may change the Offline Action for a particular client on the Mobile Administrator, this change
will only come into effect once the client has been able to successfully logon to the Mobile Filter server and
pick up this new configuration setting.

Note:  You can install CNDS to make sure that the client only switches off when it is within it’s own 
network and not someone elses. See ‘CNDS’ in the Mobile Filter Installation Guide for details on how to 
install this service.
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